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Introduction 

Welcome to Easy Way PivotTables and PivotCharts Excel 2013. 
 
This book has been written using Microsoft Excel 2013 with Windows 8.1. (The Windows 7 
operating system can be used. However screen shots will differ slightly from those shown in 
this book.) 
 

Retrievable Exercise Files 
Some exercise files have been created for you to prevent time in keying in many exercises.  You 
can then open these files and use the features of Excel to manipulate and format text.   

A list of these files is shown on page ix and instructions for downloading these files from our 
web site are included on page x. 
 

What you will learn 
In this course you will learn how to - 

Use a pivot table to display data: 

 Create and edit a pivot table 

 Create a pivot table report including a pivot chart 
 

How you will learn 
This book is divided into sections.  Each section page lists the learning outcomes for that 
section.  You will work through each section and do all exercises. 

Revision theory is included at the end of the section with a Consolidation Exercise at the end 
of Section 3.  Our books include accumulation and consolidation of learning which carries 
across each section.   
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Word meaning boxes 
Sometimes you will see a box at the left side of the page of a line that has dotted underlining. 
This box will contain information to help you understand the meaning of the underlined word 
(or how that word is formed).  An example is shown below. 
 
Data can therefore be altered to re-calculate budgets and to forecast results using different 
sales figures.  Worksheets can be saved, opened and printed as required. 
 

Different Excel buttons 
Depending on the size of your Excel screen, buttons on the ribbon may vary to those shown in 
this book.  The icon with the word of that feature may show, or the icon only. 
 

For example, the Copy button in the Clipboard group on the Home tab may be displayed in 
either of the following ways. 

  OR   

The Symbol button can show as either - 

 OR  
 

Shortcut keys 
Shortcut keys are indicated in the left margin, usually the first time they are used.  An example 
follows. 

1 Click on the Save button  on the Quick Access Toolbar  . 

2 Type a file name for your document then click on Save.  
 

Glossary 
Generally when a word(s) is first used that is a technical term or a word that you may not know 
that relates to an exercise, or a particular Excel 2013 feature, a description is given.  You will 
also see that such words are in SMALL CAPS.   

These terms are listed on each section page, an example is shown below.  Explanations are also 
included in the Glossary at the end of the book. 
 
 

 

In this section you will come across the following words highlighted in bold. This 
indicates that the word is included in the Glossary at the end of the book together 
with a description of that word. 

AUTOCORRECT FORMAT REPLACE 
CLIPBOARD MICROSOFT OFFICE HELP SELECTING TEXT 
CORRECTION SIGNS MOVE TEXT SYNONYMS AND THESAURUS 
CUT NAVIGATION PANE TYPING REPLACES SELECTION 
DRAG AND DROP PROOF-READING UNDO 
FIND REDO  

  

forecast  
=  to 
calculate a 
future 
result  

Ctrl S 
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Icons used in this book 

This book contains icons to help guide you in your learning.   

The following list shows the icon and its meaning. 

 

 Learning Outcomes 
Learning Outcomes are displayed on the section page and describe what you will learn in that 
section. 

 
 

 EXERCISE 1 
These are the exercises that you are required to do.  Often there will be an introduction 
sentence to tell you what you will be doing in that exercise.   
 
 

These are notes for your information. 

 
 

 Revision 

This appears at the end of each section and contains theory revision questions relating to 
features learnt in that section. 
 
 

 Consolidation Exercise 

The Consolidation Exercise at the end of Section 3 covers a review of topics learnt in this book 
and provides additional practice. 
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Save Options 

When a document is saved you will be requested to select the location, ie Computer then click 
on the Browse button and select the folder required.  You can eliminate this procedure by 
selecting the location and saving directly to the Save dialog box and therefore bypass Backstage 
view.   

For the purposes of this book we have used the Documents folder within This PC as the default 
folder. This folder is shown below which is the shortcut for the actual path name of 
C:\Users\User Name\Documents.  This means that files you open and save will be on your hard 
drive.  

 

 

Use the following instructions to specify the Documents folder as the default file location: 

1 Click on the  tab then click on . 

2 Click on  at the left. 

3 Ensure that the Documents folder is displayed as the Default local file location as shown 
below.   

 

4 Also ensure that Don’t show the Backstage when opening or saving files option displays a 
tick. 

5 Remove the tick from the next option Show additional places for saving, even if sign-in 
may be required. 

6 Click on OK. 

 

If you wish to open and save files to OneDrive (ie the cloud) use instructions on the next page. 

If you have Windows 8, or have updated to Windows 8.1 from Windows 8, SkyDrive may be 
displayed instead of OneDrive but is essentially the same. 
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OneDrive 

OneDrive is a cloud storage application from Microsoft.  It is one of the major online file storage 
options competing with Dropbox and Google Drive. 

Because files are stored “in the cloud” (in addition to your hard drive) it means that you can 
access those files from anywhere in the world because you will always have access to the 
OneDrive application and your files.  You do however need an Internet connection for the files 
to be updated from your hard drive to OneDrive.  

 
 

Saving to OneDrive 
OneDrive is automatically set up when Microsoft Office 2013 (ie Office 365) is installed on your 
computer.  A OneDrive folder will be displayed on the Navigation Pane in Windows Explorer as 
below.  

 

Files can be saved manually by clicking on the Save button  on the Quick Access Toolbar, 

specifying a name for your file then clicking on the  icon (you may wish to double 
click on Documents and save to that folder). 

 
OneDrive as the Default File Location 
Use the following instructions if you wish to specify OneDrive as your default file location. 

1 Click on the  tab then click on . 

2 Click on  at the left. 

3 Ensure that the C:\Users\User Name\OneDrive\Documents folder is displayed as the 
Default local file location as shown on the next page. (You may need to retype the 
location)  

4 Also ensure that Don’t show the Backstage when opening or saving files option displays a 
tick. 
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5 Remove the tick from the next option Show additional places for saving, even if sign-in 
may be required. 

 

6 Click on OK.  

OneDrive Website 
You can log in to the OneDrive website using your web browser with your login name and 
password. 

The website is www.OneDrive.live.com. 

 

You can upload photos and use files and share files. 

New files can be created through OneDrive by clicking on  and selecting 
the program you wish to use, eg Excel (web applications in OneDrive are slightly 
cut-down versions of Office 2013 programs).  

 

Sharing Files 
From within Excel 2013 you can save files to OneDrive (usually to the Documents folder) and 

then share those files.  You can then click on the  tab, on  and invite people to 
share files in OneDrive.   

Alternatively, you can right click on a file in the OneDrive website (see above) and select 
Sharing. 

Use Google in your web browser to search for additional information on OneDrive.   
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Exercise Files used in this book 

 
(Instructions are included on the following page for downloading retrievable files 

from our web site at www.cherylprice.co.nz) 
 
 

Names of files 

Cavanagh Industries PC Sales – PivotChart 2 

Home Ideas (Categories) 2 PC Sales – PivotChart 

Home Ideas (Categories) PC Sales 2 

Home Ideas PC Sales 

Mykas – Adelaide PivotChart 2 

Mykas – Brisbane PivotTables 

Mykas – Melbourne PivotTables - Group 

Mykas – Sydney Real Estate Sales 

Organic Foods Co 2 Rep Sales 

Organic Foods Co 3 Sports Galore Orders 
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Downloading Exercise Files 

The exercise files listed on the previous page can be downloaded from the Cheryl Price web 
site using the instructions below. 

 For the purposes of this book we have specified Exercise files to be downloaded to the 
Documents folder within This PC which is the shortcut for the actual pathname of  
C:\Users\User Name\Documents.  This is where files will be opened from and saved to. 
 
 

  

 

1 In the address bar of Internet Explorer, type: www.cherylprice.co.nz 

2 Press Enter on the keyboard to display the Cheryl Price website. 

3 Click in the Resources tab as shown at the right. 

4 
Under the heading of Easy Way Books - Computing 

Click on Easy Way – PivotTables and PivotCharts   

5 Under the Exercise Files heading click on the underlined blue hyperlink, ie     

PivotTables and PivotCharts Excel 2013  Free download 

The File Download dialog box will display.   

6 a Click on then  

b Change file name to  PivotTables and PivotCharts Excel 2013 Exercise Files. 

c Click on the Documents folder shown below. 
 

 

 

The Documents folder under This PC is the shortcut for 
C:\Users\User Name\Documents 

d Click on . 

7 a Click on .   

b Right click on the zipped exercise file and select Extract All.  Click on Extract.   

 A folder will be created containing the exercise files.  

c Delete the Compressed (zipped) Folder. 
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PivotTables 
 
 

 
 

 

 Learning Outcomes 
 

At the end of this section you should be able to -  

 Summarise data with PivotTables 

 Understand the Pivot Cache 

 Group and Ungroup data in a PivotTable 

 Change the values calculated in a PivotTable 

 Use a PivotTable for data consolidation 

 Choose and apply a style to a PivotTable 

 Change the PivotTable Layout 
 
 
 
 
 
 

In this section you will come across the following words highlighted in bold. This 
indicates that the word is included in the Glossary at the end of the book together 
with a description of that word. 

CLASSIC PIVOTTABLE LAYOUT 
COLUMN 
EXCEL LIST 
GROUP DATA 
NORMAL LAYOUT 
OUTLINE 
PIVOT CACHE 
PIVOTTABLE 

PIVOTTABLE AREA 
PIVOTTABLE FIELDS LIST 
PIVOTTABLE REPORT 
PIVOTTABLE STYLES GALLERY 
PIVOTTABLE TOOLS CONTEXTUAL TAB 
REFRESHING 
REPORT LAYOUTS 
ROW 

SHORTCUT MENU 
SOURCE DATA 
STYLES 
SUBTOTALS 
VALUE FIELD SETTINGS 
VALUES FIELD 
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 PivotTables 

A PIVOTTABLE is an interactive worksheet table that provides a method of summarising and 
grouping large amounts of data from an EXCEL LIST.  Data can be formatted, and summarised 
using various calculations.  A PivotTable is also referred to as a PIVOTTABLE REPORT. 

PivotTables are so called because row and column headings can be rotated around the data 
area to allow different views of the source data to be displayed.  The fields from the list are 
placed around the PivotTable skeleton to define how the summarised information is shown 
and calculated.  

When source data changes, the PivotTable can be updated. 

Excel List  
For the best results when creating a PivotTable your Excel list should have the following 
characteristics. 

 The first row of the list contains the headers that identify the data in each column.  The 
list does not have to start in row 1 of your worksheet or in column A. 

 Each COLUMN (field) contains unique data. 

 Each ROW (record) contains one set of data for a single item. 

 There should be no blank rows or columns in the list. 

The PC Sales workbook (which you will use in the first exercise), is a good example of such a 
list. 

 

rotated 
=   
turned 
around  
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Why Create a PivotTable? 
 If you want to summarise data from an Excel list you could possibly use the automatic 
SUBTOTALS feature.  For example, in the PC Sales workbook you could display Sales subtotals for 
each Region. 

You would first have to sort the data by Region, then apply the Subtotal feature (Data Tab, 
Outline Group).   

 

Using the automatically applied OUTLINE you could show or hide data levels, but if you required 
subtotals based on other fields you would have to re-sort the list and apply the Subtotal feature 
again. 

When you summarise your data in a PivotTable, you can display different views of the data 
without having to recreate the table each time. 

Creating a PivotTable 
 

The Pivot Cache 

When a PivotTable is created, it is not directly linked to the data source. This is because when 
you begin the process, the first step that Excel takes is to create a duplicate copy of the data 
source and store it in a Pivot Cache.  This occurs every time you create a PivotTable from a data 
source, which automatically increases the file size and the amount of memory being used.   

When you make changes to the data source, this is not automatically reflected in the 
PivotTable.  This is easily managed by REFRESHING the data. 

Efficient use of the PIVOT CACHE and how to refresh data is covered later in this section. 
    
  

summarise 
=  to 
condense 
or reduce  
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 EXERCISE 1 

1 Open the workbook called PC Sales 

2 Ensure the Database worksheet is displayed. 

3 With the cursor anywhere within the list, click on the  tab then on .   

The Create PivotTable dialog box is displayed. 

4 Ensure the Select a table or range and New Worksheet options are selected and that the 
Table/Range is as shown below. 

 

5 Click on OK.   

A new sheet is inserted to the left of the Database worksheet (Sheet1); a PIVOTTABLE AREA 
is displayed, together with the PIVOTTABLE FIELDS LIST  Task Pane (at the right) and the 
PivotTable Tools, Analyze and Design tabs as shown below. 
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There are two ways in which a PivotTable can be used and manipulated: 

 NORMAL LAYOUT as shown on the previous page. 

 CLASSIC PIVOTTABLE LAYOUT which displays a grid – fields displayed in the PivotTable Fields list 
can be dragged onto the grid (see illustration on next page). 

 

6 Change the PivotTable layout view to Classic PivotTable Layout as follows: 

a On the PivotTable Tools, Analyze tab, click on .   

b In the PivotTable Options dialog box click on the Display tab.  

c Ensure a tick is displayed in this option: 

 

d Click on OK. 
 

This applies the Classic PivotTable layout to the current PivotTable only.  

The PivotTable area is displayed showing all the field areas in the PivotTable.  

The fields in the database are listed in the PivotTable Fields list Task Pane at the right of the 
screen. 

 

PivotTable Location Notes 

When creating a PivotTable you specify where you want it located in the Create PivotTable 
dialog box.  The usual recommendation (which is the default option in the Create PivotTable 
dialog box) is that it is placed on a new worksheet. 

If you decide later that you want to move a PivotTable to a different location, follow these 
steps: 

1 Select a cell in the PivotTable. 

2 In the Actions group on the PivotTable Tools, Analyze tab, click on .   

The Move PivotTable dialog box is displayed. 

 

3 Specify where you want the PivotTable moved to, then click on OK. 
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PivotTable Organisation 
You specify the fields you want to include in the PivotTable by either dragging them to the 
appropriate area in the lower half of the Task Pane  

OR  

To the PivotTable area itself (if you are displaying the Classic PivotTable layout). 

 

 

The four areas that make up a PivotTable are described on the next page. These are shown in 
the PivotTable Area and also in the lower half of the PivotTable Fields list.  

The names used in the PivotTable Area are slightly different to those used in the PivotTable.  
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Report Filter/Filters  

 This contains the field(s) that control how the data is presented and how it can be filtered.   

In effect, individual PivotTables are created for each possible value in the Report Filter Field as 
well as for all the values. 

For example, in PC Sales the Report Filter Field could be Year, which would produce three pivot 
tables:  

 one for 2010 

 one for 2011  

 one for both years combined  

Only one of these PivotTables is displayed at any given time, depending on which Report Filter 
Field value is selected.   

Similarly, if Region was specified as the Report Filter Field, the data for all regions or for 
individual regions could be displayed.  

Column Fields/Columns 

Column Fields are used to create the horizontal axis of the PivotTable.   

If more than one field is placed in the Column Labels area you should place them in descending 
order of importance.   

For example, you would place Month below Year in the Column Labels box in the PivotTable 
Fields list so that sub-totals for each month within each year could be created. 

Row Fields/Rows 

Row Fields are used to create the Vertical Axis of the PivotTable.   

You can place more than one field in the Row Labels area using the same method as described 
above for placing multiple Column Fields. 

Value Fields/Values 

Field(s) placed in the Values area contain the data to be summarised using any of the available 
functions such as Sum, Average, etc.   

A PivotTable must have at least one VALUES FIELD.  

 
Totals and Subtotals 

When a PivotTable is created, subtotals and grand totals are automatically generated.  These 
can be deleted or hidden if required. 

Because these totals are produced based on the data in the list, you should ensure that the list 
does not also contain subtotals. 
  

filtered 
=   
sorted, 
extracted 
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8    SECTION 1  Cherylprice.co.nz Limited 

 EXERCISE 2 

The PivotTable will initially be set up to display the sales for all products for each salesperson 
within each region. 

1 Drag the Product field to the Filters area as shown below. 

    

 

2 Drag the Salesperson field to the Rows area. 

3 Drag the Region field to the Columns area. 

4 Drag the Sales field to the Values area. This will be labelled Sum of Sales – Sum is the 
default function.   

The fields are also displayed in the actual PivotTable area on your worksheet. 

Drag the 
Product field 
from here 
down to the  
Filters area 

The Product field is also 
displayed in the PivotTable grid 
as shown below. 

The Product field is now 
displayed in the Filters area 
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 Cherylprice.co.nz Limited SECTION 1    9 

If you are using the Classic PivotTable layout you can also drag the fields onto the 
appropriate section of the PivotTable area.  

If you place a field in the wrong area, simply drag it to the correct area.   

The PivotTable is displayed as shown below. 

 

5 Rename the worksheet PivotTable 1. 

6 Click on the Product (All) down arrow in cell B1.   

The options shown below will be displayed. 

 

7 Select Hardware to view only hardware sales.  Click on OK.  

 

The down arrow button now shows as , indicating that the PivotTable is filtered. 

8 Click on the Product , select Software and click on OK. 
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PivotTable Tools Contextual Tab 
When you select any cell in a PivotTable, the PIVOTTABLE TOOLS CONTEXTUAL TAB  is displayed on 
the ribbon.  It includes two tabs – Analyze and Design. 

The Analyze Tab 

The Analyze tab includes a wide range of options that allow you to modify calculations, update 
the table data, show or hide elements of the PivotTable, etc. 

 

The Design Tab 

The Design tab allows you to adjust the layout of the table, apply preset styles to the table, etc. 

 

The PivotTable Fields list is also displayed whenever your active cell is within the PivotTable. 
 

 

 EXERCISE 3 
 Click outside the PivotTable. The PivotTable Tools contextual tab and the PivotTable Fields 

list are hidden. 
 

Displaying Report Filter Pages 
Individual PivotTables for each unique value in the Filters field can be created on separate 
sheets (pages) in the workbook. 
 

 EXERCISE 4 

1 Select a cell in the table, click on the Product down arrow  in cell B1 and select (All).  

2 Click on OK. 

3 On the PivotTable Tools, Analyze tab, click on the Options button down arrow in the 
PivotTable group.  

 

4 Select . 
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5 Click on OK.   

Two new worksheets will be inserted into the workbook, one for each Product category. 

 

6 Review the Hardware and Software worksheets, and then return to PivotTable 1 (which 
shows All). 

 

Changing the Layout 
In the following exercise the PivotTable layout will be changed to display the product sales for 
each salesperson with a subtotal for each salesperson. 
 

 EXERCISE 5 
The lower half of the PivotTable Fields list will be used to reorganise the fields by dragging them 
from one box to another. 

1 Drag the Product field which is in the Filters box so it is under the Salesperson field in the 
Rows section of the PivotTable Fields list as shown below. 

 

The table will be displayed as follows. 
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12    SECTION 1  Cherylprice.co.nz Limited 

2 Rearrange the fields as follows. 

 

The PivotTable is now displayed as shown below. 

 

3 Click on the Salesperson (All) down arrow , select Evans and click on OK. 

4 Click on the Product (All) down arrow , select Software, and click on OK. 

 

5 Redisplay the data for all Salespersons and Products. 

6 If necessary, click in the PivotTable to show the PivotTable Fields list. 

Rearrange the PivotTable to display as shown below.  (See if you can do this on your own 
– then look at the next page to see how the fields are positioned in each field box.) 
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